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Introduction

This guide provides a general overview of Peak to new
users.  You will be introduced to Peak’s user interface, as
well as many of its basic controls.  Over the course of this
tutorial, you’ll learn how to configure Peak for recording,
how to perform basic cut/copy/paste edits, use reference
markers and regions, and to produce a Red Book format
audio CD that can be played in any CD player.   

This guide is written with the beginner in mind, and is
geared toward users who have little or no experience
with editing audio on their computer.  For more detailed
explanations of particular features, consult the Peak
User’s Guide in: 

Macintosh HD/Library/Documentation/BIAS/Peak 4 Documentation 

When learning to use Peak, it’s a good idea to have a spe-
cific project in mind.  By focusing on a particular task,
rather than learning every feature at once, you’re less
likely to be overwhelmed.  The concepts, tools, and tech-
niques you will learn in this tutorial will apply to many
other audio projects.  The goal of this tutorial is based on
a very common question from Peak users – “how can I
record cassettes from a stereo system  into Peak, and
then burn a CD?”

Additional tutorials on using BIAS software products for
various types of projects are available for download from
the BIAS website, at: 

http://www.bias-inc.com/downloads/documentation

This tutorial guide assumes that you are familiar with
standard Macintosh operating techniques, including:

• Setting up, starting, and using your Macintosh

• Choosing commands from menus

• Double-clicking, selecting, Shift-selecting, and
dragging with the mouse

• Opening, copying, saving and deleting files

• Opening, closing, scrolling, moving, re-sizing, and
selecting Macintosh windows

If you don’t know how to perform these tasks, please
refer to your Macintosh User’s Guide and spend a little
time learning about your Macintosh before going any fur-
ther.  This will make using Peak much easier and more
enjoyable.
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This guide also assumes you have completed the
required registration and authorization process.  

If you need help registering or authorizing your software,
please visit:

http://www.bias-inc.com/support/register

or email:  register@bias-inc.com

What is Peak?

Peak is a digital audio recording, editing, processing and
CD mastering application.  In many ways you can think of
Peak as comparable to a word processor.  Both allow you
to edit content, and move things around.  A word proces-
sor lets you do these things with text, whereas Peak lets
you do these things with audio.  In Peak you can cut,
copy, and paste just as you can in a word processor.  In
Peak, as in a word processor, you work with individual
document files, and can quickly open a file, edit the con-
tent, and save it.  The word processor analogy will be
helpful in your understanding of the basic editing fea-
tures of Peak, and provide a reference point as you learn
the basics of audio editing with Peak.  

What is Peak Used For?

Peak can be used for a wide variety of audio projects.  For
example, Peak’s current user base consists of profession-
al mastering engineers, sound designers, sample library
creators, post-production editors, archivists – as well as
hobbyists using Peak to “sweeten” the audio in their
home digital video projects, to make custom mix CDs, or
record their LPs and convert them to mp3 or mp4 format
for use in their iPods.  However, Peak is a powerful and

versatile application that can be used in practically any
project that involves audio.

Some of the most common types of projects Peak is
designed for are:

• Recording LPs and tapes, and archiving them to
CDs and mp3/mp4 files

• Making stereo recordings of lectures or live per-
formances

• Recording and editing voiceovers

• Sample editing, loop editing, and sound design for
creating sound effects

• Creating audio files with reference markers as cue
points for use in web design and multimedia appli-
cations

This guide focuses on recording an audio source, per-
forming basic edits, and burning an audio CD.  The tech-
niques you learn can also be applied to many other audio
projects.

Launching Peak for the First Time

When Peak is launched, you will see the Toolbar and
Transport windows, as well as an Open dialog – as shown
in Fig. 1 one on the opposite page.  

Open Dialog

When you launch Peak, the Open dialog box appears
automatically – at this point, Peak is ready to begin edit-
ing, and is prompting you to open a digital audio file.  All
other menus and commands remain “greyed out”
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(unavailable) until you respond to this dialog box.
Options in the Open dialog include selecting a file to
open from your hard drive, auditioning a file from your
hard drive, or canceling.  Since we are learning about the
interface, click “Cancel” to close this dialog box.  At any
time, you may access the Open dialog by choosing the
Open command from the File menu.

Peak defaults to having this Open dialog pop up
each time you launch the program.  If you would
like to turn this option off, you can uncheck “Open

Dialog after Launch” in the Options menu.
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Fig. 1 – When Peak is first launched, you’ll be prompted to open an audio document

Fig. 2 – The Open dialog allows you to audition and open digital files
from your hard drive



Toolbar

Peak’s Toolbar (Fig. 3) appears across the top of your
screen by default, and may be moved to any desired posi-
tion.  In addition to its horizontal orientation, the Toolbar
may also be used in a vertical orientation, or as a cluster
of buttons.  Adjustments to the shape of the Toolbar are
made by clicking and dragging the window resize box,
located at the lower right corner of the Toolbar window.
Toolbar button sizes may also be customized – to change
the size of the buttons, choose Preferences from the
Peak menu, and then click the Shortcuts/Toolbar
Preferences button.  In the Shortcut/Toolbar Preferences
dialog, use the Toolbar Button Size slider to make adjust-
ments.

Toolbar  button sizes can only be customized in

the full edition of Peak.

The Toolbar contains easy-to-access shortcuts to many of
the most frequently used tools in Peak.  For example, you
will find buttons in the Toolbar for opening and closing
files, for cutting, copying, and pasting, as well as common
DSP tools, such as Normalize and Change Gain.

To find out what a particular button does, simply move

your mouse over the button, and Peak’s automatic “bal-
loon help” will display its function.  If you’re unsure
about what a button is used for after reading its text
description, check your Peak User’s Guide for more
details.

Transport

The Transport window (Fig. 4) appears across the bot-
tom of your screen by default, and can be moved to any
desired horizontal position.  Although the Transport may
only be used in a horizontal orientation, its length is cus-
tomizable.

This window contains Peak’s Transport controls (Play,
Stop, Record, etc.) as well as a digital counter, a dB scale,
precision VU (level) meters, and a master fader (volume
control).

Main Menu Set

Much like other Macintosh applications,  Peak contains a
number of menus along the top of the screen (Fig. 5).
Virtually all of Peak’s commands may be accessed via these
menus (many of the same commands appear in the
Toolbar) – including most of Peak’s configuration settings.

Getting Started with Peak4

Fig. 3 – Peak’s Toolbar allows easy access to commonly used tools and commands

Fig. 4 – Peak’s Transport window controls playback, as well as master volume – and displays the playhead cursor’s position and audio level

Fig. 5 – All of Peak’s commands and tools may be accessed from the main set of menus that appear across the top of your screen



We will go into more detail about these menus in other
sections of this guide, but take some time to familiarize
yourself with the different menus and their contents.

Most of the menu contents in Peak have keyboard

shortcuts associated with them.  When a keyboard
shortcut is available for a particular menu com-
mand, you will see the keyboard equivalent dis-
played next to it in the menu.  The full edition of
Peak allows you to create custom keyboard short-
cuts for most of Peak’s menu commands.

Learning the keyboard shortcuts can make editing in Peak
much faster and more efficient.  Learning them all may
seem daunting, but if you try to learn one or two during
each editing session,  soon you’ll be editing like a pro!

These are the basic elements of the Peak interface.  In
the next section, we will navigate  through the user inter-
face and set Peak up to record audio.

Configuring Peak to Record

In this tutorial, we’ll be recording through the
Macintosh’s built-in audio inputs.  If you are using audio
hardware other than the built-in sound input on your
Macintosh, you can visit our hardware setup page on the
BIAS website for directions on how to configure your

particular device.  Directions for configuring many popu-
lar audio hardware devices can be found at: 

http://www.bias-inc.com/support/hardware

Let’s assume we’re going to record audio from a portable cas-
sette player into Peak – perhaps to digitize old cassettes...
Before we dive into Peak, we must first connect the two devices
together, so that the audio output from the cassette player is fed
into the Mac’s Sound In port.  The cassette player used in this
example has a 1/8” stereo headphone output – we’ll use a 1/8”
to 1/8” stereo cable to connect the two devices together.  

Other common ways to connect stereo equipment to a
Macintosh include using an RCA to 1/8” stereo cable
(sometimes called a “Y” cable), or an RCA to RCA cable.
Some newer Mac models even feature optical input,
which is a digital connection – though this would require
a compatible digital output source (not commonly found
in portable cassette players.
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Fig. 6 – Keyboard shortcuts appear in each of Peak’s menus

Fig. 7 – As this cassette player has only a 1/8” headphone output,
we’ll use this to connect to the Mac’s built-in audio input.

Fig. 8 – Other stereo systems may use different type of cables, such as
an RCA cable (shown above).



At the end of this tutorial, you will find diagrams and pic-
tures that show the various cables and ways of connect-
ing equipment together.  Based on the examples provid-
ed, you should be able to use one of the configurations
with your own stereo equipment.

To Connect Your Audio Devices Together:

1.  Plug one end of the 1/8” stereo cable into the head-
phone output on the cassette player (shown in Fig.
9).  (If you’re not sure which connection to use,
look for one labeled “Phones”, “Headphones”, or
an icon of a pair of headphones or a speaker.)

2. Plug the other end of this cable into your
Macintosh’s Sound In port (shown in Fig. 11).

3.  Set the output level of the boox-box to about
halfway between zero volume and full volume.

Not  all Macs have an audio input!  If your Mac
does not have an audio input, you will need an
audio hardware interface with audio input.  To
help decide on what kind of audio interface best
suits your needs and budget, BIAS recommends
visiting the technical support web page to see
which devices are compatible:

http://www.bias-inc.com/support/hardware

When you find a device that has the features you
need, visit the hardware manufacturer’s website
for details on pricing and purchasing.  

At the end of this tutorial, several examples of
audio hardware interfaces are shown, along with
information on how to set these up with your
stereo equipment and Macintosh.

Since we’ll be using the Mac’s built-in audio input for
recording, the next step is to configure the Mac’s Sound
Preferences, so the Mac “knows” to expect audio input
via the Sound In port, rather than the built-in mic for
example.
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Fig. 9 – Example of a 1/8” stereo headphone output on a cassette
player

Fig. 11 – The built-in audio input on an 800mHz Titanium Powerbook

1/8” stereo input

1/8” stereo output

Fig. 10 – The cable used to connect these two devices has a 1/8”
stereo connector at both ends



To Configure System Preferences for Sound:

1.  From the Apple menu, choose System Preferences.

2.  In the Hardware section of the System Preferences
window, click the Sound icon.

3.  Click the tab labeled Input.

4.  In the section labeled Choose a Device for Sound
Input, choose Line In.

5.  Move the Input Volume slider to halfway between
the lowest input level and the highest input level.

6.  Insert the cassette you wish to record in the cas-
sette player, and start playback.

7.  In the Sound Preferences Pane, you should now
see activity in the VU (level) meters – ideally, the
signal level should be higher than halfway up the
VU meters, but not all the way to the top.

When recording digitally, you want to have a nice

strong signal to record, but this should never
exceed 0 dB, as this will result in “clipping”, or dig-
ital distortion.  It’s always better to record with a
lower level, as Peak contains tools to bring these
levels up after recording, but once a digital
recording is “clipped” it is very difficult (if not
impossible) to salvage!

8. When you have found the ideal recording level,
close the System Preferences.

Now that your Macintosh is getting an audio input signal,
we must also configure Peak to use the Mac’s built-in
audio input hardware to actually record the signal.  
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Fig. 12

Fig. 13

Fig. 14

Fig. 15

Fig. 16

Fig. 17

Fig. 18



Core Audio

Peak is able to access the Mac’s built-in audio hardware using
a part of the Mac OS called Core Audio.  Core Audio is an
advanced audio driver system that allows audio software
such as Peak to communicate with the audio hardware.  In
addition to allowing audio software to “talk” to audio hard-
ware, it also offers a number of options for recording, such
as bit depth, sample rate, how many channels are being
recorded (stereo – two channels, mono – 1 channel, or
multi-channel – x-channels).  The Mac’s built-in audio hard-
ware is only capable of recording one (mono) or two
(stereo) channels of audio at a time.  As we’re recording
from cassette, we only need one or two channels, depend-
ing on whether the audio material on the cassette was origi-
nally recorded in mono or stereo (stereo is the most com-
mon for commercially produced cassettes).  Core Audio sup-
ports recording at various bit depths and sample rates.  If
you are not familiar with these concepts, here’s a little back-
ground information about digital recording that may be of
use.

A Brief Explanation of Digital Audio

If you are new to digital hard-disk-based recording, you
may wish to acquaint yourself with a few of the principles
behind digital audio before you dive into using Peak soft-
ware.  This section explains a few key concepts that will
give you a good general understanding of how Peak does
what it does.  What we hear as sound is actually a pattern
of pressure waves that move through the air.  The frequen-
cy of these waves determines the pitch of the sound – how
low or high it sounds.  Sound frequency is measured in
cycles per second, or Hertz (Hz).  The range of human
hearing is generally considered to be from about 20 Hz at
the low end to 20 kHz at the high end.  In practice, howev-
er, most adults hear only as high as 12 kHz to 18 kHz, espe-
cially those of us who may have spent more time than we

should have with headphones at high volume or at loud
rock concerts.

Sampling and Sample Rate

Your Peak software-equipped Macintosh computer stores
audio digitally.  This means that analog electrical signals
from microphones or other sources are converted into
numbers by a circuit called an analog-to-digital converter
and stored on hard disk.  The analog-to-digital (A/D) con-
verter uses a technique called digital sampling to convert
analog electrical signals into numbers.  Digital sampling is
the sonic equivalent of taking a snapshot.  By taking thou-
sands of little digital samples per second and storing them
to a hard drive, an A/D converter can capture an accurate
sample-by-sample representation of a sound, much like a
movie is a frame-by-frame representation of a moving
image.  The number of samples taken of the audio in a
second is called the sample rate.  The sample rate deter-
mines the recording’s upper frequency response.  A high-
er sample rate delivers higher frequency response.  As a
rule of thumb, a digital recording’s upper frequency
response is roughly half of its sample rate (known as the
Nyquist frequency).  The audio on compact discs, for
example, is recorded at 44,100 samples each second, or
44.1 kHz.  This sample rate is the standard for profession-
al-quality digital audio, and provides an upper-end fre-
quency response of approximately half the sample rate
(known as the Nyquist frequency):  22.5 kHz, somewhat
higher than most people’s hearing range.

Bit Resolution

Another factor that affects the quality of the audio is the
resolution of each sample.  The greater the resolution,
the better the quality.  To use an analogy from the film
world, just as image resolution and quality increase with
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film size (8 millimeter film is much lower in image quali-
ty than 70 millimeter film) greater bit resolution (8-bit,
16-bit, 24-bit, and 32-bit) results in better fidelity digital
audio.  Audio CDs have a resolution of 16-bits.  In prac-
tice, the bit resolution determines the recording’s
dynamic range – that is, how many distinct steps you
have to describe a sound’s level, from quiet to loud.  For
instance, an 8-bit recording has 256 (28) levels available,
which is the equivalent of 48 decibels (dB) of dynamic
range.  On the other hand, a 16-bit recording has 65,536
(216) levels available, equivalent to 96 dB dynamic range.
(The rule of thumb for determining the dynamic range in
decibels is to take the bit rate and multiply it by 6.)

To set Peak up for recording through the Mac’s built-in
audio input using Core Audio, follow the steps below.

To Configure Peak for Recording Through the Mac’s Built-
In Sound Input:

1.  Launch Peak.

2.  Click the Cancel button when prompted to open
an audio document, as we will be recording a new
document into Peak.

3.  From the Audio menu, select Sound Out (Fig. 19),
and make sure that Core Audio is selected in the
sub-menu – a dialog box called Core Audio
Playback appears (Fig. 20).

Peak can record using the other types of drivers list-

ed, such as Mac OS X Audio HAL, or Firewire DV, but
those are beyond the scope of this tutorial.

4.  Click OK in the Core Audio Playback dialog.

5.  From Peak’s Audio menu, select Record Settings  –
this dialog (shown in Fig 21) gives you access to
many of Peak’s recording options.  

6.  In the upper left portion of the Record Settings dia-
log, click on the Record Disk pop-up menu, and
choose the drive you wish to record to.
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Fig. 21 – Peak’s Record Settings dialog

Fig. 19

Fig. 20



By default, this menu is set to Largest Drive –
which may not necessarily be the drive you wish to
record to.  Since the amount of data on different
hard drives can change, this default setting does
not guarantee that you will always record to the
same hard drive.  By selecting a particular drive
in the Record Disk pop-up menu (shown in Fig.
22), you can be sure that your audio is always
recorded to the same drive, provided that drive is
always connected to your computer system.  If you
have multiple drives connected to your Macintosh,
it’s best to record to the fastest drive.  For example,
if you use a Powerbook with an external FireWire
drive, it’s best to record to the external FireWire
drive, as this will typically have a faster data
transfer rate.  In addition, the Powerbook’s inter-
nal drive is running the Macintosh operating sys-
tem, so it’s constantly busy accessing data to run
the computer itself.  By recording to a different
drive,  the internal (or boot drive) drive can be
used just for accessing parts of the Mac OS, while
the second drive only  records audio.

Recording to a separate drive is the ideal situation, but
for our purposes here, of recording a mono or stereo sig-
nal from a cassette, any OS X compatible Mac in good
condition should be able to record to the same drive that
runs the operating system – that is, on a Mac with a sin-
gle internal hard drive.

7. In the right side of the Record Settings dialog,
make sure the Monitor checkbox is checked.

On the right hand side of the Record Settings dialog

box, you’ll see a column of checkboxes.  These are
various recording options that can be enabled or dis-
abled.  For beginners, the most important checkbox
here is the “Monitor” option.  The Monitor option
allows you to hear the audio that you’re recording, as
it’s being recorded.  Since we’re recording from a cas-
sette player, using the headphone output, we won’t be
hearing any audio from the cassette player’s speak-
ers, so we’ll want to have record monitoring enabled.

The next items to configure are audio hardware settings.  

8.  In the Record Settings dialog, click the Hardware Settings
button – the Core Audio Settings dialog appears.

9.  In the Core Audio Settings dialog, select Built-In
Audio from the Input Device & Output Device pop-
up menus.
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Fig. 22 – The record disk pop-up menu lets you specify which drive
you would like to record to (when multiple hard drives are connected
to your Mac).

Fig. 23 – The monitor option lets you hear what’s being recorded
through your computer’s speakers

Fig. 24



10.  Click OK to return to the Record Settings dialog.

11.  In the Record Settings dialog, click the Device and
Sample Format button – the Core Audio Record
Settings dialog appears.

12.  From the Record Through pop-up menu, choose
“In 0 1 & 2”.

13.  From the Sample Rate pop-up menu, choose
“Auto”.

14.  From the Clock Source pop-up menu, choose
“Internal”.

15.  In the section labeled “Channels:”, click the radio
button that suits the audio material you are record-
ing – either stereo or mono.

16.  In the section labeled “Bit Depth:”, click the 16-bit
radio button.

17.  Click the OK button to exit the Core Audio Record
Settings dialog.

At this point you are ready to record audio with Peak.  

Recording Audio with Peak

Now that you have connected your source (the cassette
player) to your Mac, and have configured your Mac’s
audio input settings, and Peak’s record settings, you’re
all set to record.  Follow the next few steps to make your
first recording.

To Record Audio in Peak:

1.  Click the Record button in Peak’s Transport win-
dow – the Record dialog appears.

The Record dialog box has its own set of control

buttons in it, similar to the buttons in the
Transport window.  Please note that while the
Record dialog is open, all other menus and but-
tons are inaccessible.  Click the Stop button (with
the black square icon on it) to close the Record
window.
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Fig. 25 – These are very common settings to use when recording with
the Mac’s built-in audio inputs.

RecordRecord Settings Pause StopFig. 26



At this point, Peak is armed for recording, but is
not yet recording audio.  In this state, you can
check that Peak is receiving input signal and
check your recording levels.  Play the cassette for

approximately 30 – 60 seconds, and keep an eye

on the levels.  Assuming that you are recording a
song (rather than spoken word), gauge the record-
ing level by the loudest part of the song.  For exam-
ple, if you are recording rock music, with a loud
guitar or drum solo, this is the best part to use for
setting the recording level.  The loudest part of the
song should register around –6dB on Peak’s VU
meters.  If the loudest part of the song peaks the VU
meters around –6dB, then all other parts of the
song will register lower, and no part of the song
will ever “clip”, or become distorted.  If you notice
that the level is too high or too low, there are a cou-
ple of ways to adjust it.  One method would be to
simply turn up the volume level on the cassette
player until the meters in Peak are getting the

appropriate signal level – another method is to

exit the Record Dialog in Peak, return to the
System Preferences/Sound, and increase the Input
Level Slider’s setting.  When recording from a
device such as a cassette player, with a variable
output volume, you’ll often find that there is an
ideal setting for its output volume, as well as an
ideal setting for the Input Level Slider in the System
Preferences/Sound.  Beginning with both settings

at about halfway is a good starting point – you

can fine-tune as necessary.

2.  Rewind your cassette to the point from which you
wish to start recording, and start playback.

3.  In Peak’s Record dialog, click the Record button –
note that the countdown timer in the Record dia-
log is now counting.  The amount of recording
time remaining depends on how much space is
available on the hard drive you are recording to
(Fig. 28).

4.  When one complete side of the cassette has been
recorded, let Peak “keep rolling” and turn over the
cassette and start playback of the second side.
Since Peak is an editor after all, it’s easier to let it
keep recording, and edit out the unwanted record-
ed silence later.

5.  When you’ve recorded both sides of the cassette, click
the Stop button in the Record dialog.  Peak will
prompt you to name the recorded file, and to choose
a location on your hard drive to save it – Peak will only
allow you to save the recording to the hard drive you
selected as your Record Drive (please refer to step 6
in the previous section “To Configure Peak for
Recording Through the Mac’s Built-In Sound Input:”)
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Fig. 28

Fig. 29



When you have successfully saved your recording, it will
open up in an audio document window.  Now that you
have your file open, let’s look at the different compo-
nents that make up an audio document window in Peak.

The Audio Document Window

Peak’s Audio Document windows (Fig. 30) contain a
Waveform Display, an Audio File Info Bar, a Max Level
Indicator in the lower left corner, and an expandable con-
tents drawer containing information about reference,
region, and loop markers.

Only the full edition of Peak features an expand-

able Contents Drawer – Peak Express, Peak LE
and Peak DV do not offer this feature!

The main portion of the audio document window is the
waveform.  The waveform is a visual representation of
your audio file.  The waveform is made up of a series of
peaks and troughs – the higher the peak, the louder the
audio. 

Notice that the waveform portion of the window is divid-
ed into two sections.  The upper section (smaller wave-
form display) is the File Overview (Fig 32 on next page).
The File Overview allows you to see the entire file,
whether it’s ten seconds long, or two hours long.  The
File Overview is primarily used as a navigational aid –
anywhere you click in the Overview will start playback at
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Fig. 30
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that point in the audio document.   The white box the
appearing in the File Overview is the Detail Area.
Depending on the Zoom Level, this box represents the
audio waveform that appears in the larger waveform dis-
play in the lower half of the audio document window.

The lower section of an audio document window con-
tains a larger waveform display, where edits can be made.
In this part of the audio document, you can “target” cer-
tain sections the waveform to be cut, copied, pasted , or
duplicated.  These selected portions of audio also
become the targets for DSP tools, effects plug-ins, and for
inserting various types of markers.  

In an audio document window, you may navigate to differ-
ent parts of the file using the File Overview, the scroll

bars/arrows (shown in Fig. 31) at the bottom of the window,
or by selecting the Hand Tool (more on this feature later). 

In order to get a better view of the audio waveform, you
can use the “Zoom In” & “Zoom Out” buttons in the tool-
bar (shown in Fig. 34 on the next page).

Peak’s audio document window also contains a tool icon
for each cursor mode.  The default cursor is a standard
Arrow Cursor.  You can also select a Hand Cursor for 
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Fig. 32 – The File Overview is a navigational aid – it always shows the entire length of an audio document, regardless of length...  Notice
the shaded detail area, showing what portion of the waveform is currently being viewed in the main waveform display (below).

Fig. 33 – This is the part of the audio waveform where you can make selections, cut, copy, paste, delete, etc.  What you see in this wave-
form display is represented by the shaded area in the File Overview (above).

Peak’s Waveform Displays

File Overview

Main Waveform Display

Fig. 31 – The scroll bar or scroll arrows in the audio document window
allow you to move through the audio waveform from left to right



moving a waveform within its window, a Pencil Tool for
drawing directly on the waveform at the sample level,
and a Magnifying Glass Tool for zooming the waveform
view in and out.  The ESC key on your computer key-
board will toggle through the four cursor modes (Fig.
35).  

To access any of these cursors, just click on the corre-
sponding icon – or press the ESC key.  To change the
cursor tool, click on a new button.  How the cursor
behaves in Peak depends on which of these tools you
have selected.

The two tools we will be focusing on for now are the
Arrow tool and the Hand tool.  

• Arrow tool – The Arrow tool is the default cursor –
it is the standard “arrow” tool that lets you click
and select on-screen items.

• Hand tool – The hand tool lets you “grab” the
waveform and scroll the waveform display to the
left or right.

Try switching between these two cursor modes and click-
ing and dragging in the main editing section and observe
how they work.  For descriptions of the other tool but-
tons and their functions, please consult Chapter 3 of the
Peak User’s Guide.

You can use the escape (ESC) key on your key-
board to toggle between cursor modes.

You should now be familiar with the main window ele-
ments of Peak’s audio document window.  In the next
section, we will discuss how to use Peak’s editing tools
along with the audio document window to enhance your
audio and give it a more professional sound.
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Fig. 34 – Zooming in gives more detail of a smaller area of the wave-
form, and zooming out gives more of a “big picture” view of the wave-
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Arrow Tool Magnifying Glass (Zoom) Tool

Pencil ToolHorizontal Lock Vertical Lock

Blending On/Off

Toggle Contents
Drawer

Fig. 35



Editing Basics

Cutting, Copying, and Pasting in Peak

The most basic editing features of Peak are the cut, copy, and
paste functions.  In this respect, Peak acts much like a word
processor.  To perform a cut or copy type of edit, you simply
highlight the portion of the waveform you wish to cut or
copy, and select the Cut or Copy command from Peak’s Edit
menu – or use the standard Mac keyboard shortcuts:

• Cut –�-X

• Copy –�-C

To paste a piece of audio that’s been cut or copied, you
simply place Peak’s cursor in the desired location in the
audio waveform, select Paste from the Edit menu, or use
the standard Mac keyboard shortcut:

• Paste –�-V

Placing the cursor in a specific location and then

using the Paste command will insert the contents
of the Clipboard in the position of the cursor, and
move any audio to the right of the cursor further
to the right (later in time).  Making a selection in
the audio waveform and then using the Paste com-
mand will replace the audio in the selected por-
tion of the waveform with the Clipboard contents.
This may result in the audio to the right of the ini-
tial selection being into a new position either ear-
lier or later in time, depending on the length of the
audio cut/copied to the Clipboard.

While we will not be using the Cut/Copy/Paste commands
in this tutorial, they are some of the most basic and impor-
tant editing commands.  The Cut/Copy/Paste commands
are featured in practically every Macintosh application, and

operate in much the same way in Peak as they do in a word
processing application.

Undoing Changes

As you get into the editing process, keep in mind that Peak
features an independent and unlimited edit history list –
meaning that you can “undo” as many edits as you like, all the
way back to the original state of a file.  This unlimited edit his-
tory list is independent for each file, so if you’ve made fifteen
edits in one file, and ten in another, you can switch back and
forth between the files and access each file’s edit history list.

Keep in mind that this list is available until you save the file
– once you save, the list disappears!  If you wish to save
your files at various stages of a project, and maintain the
ability to have unlimited “undos”, simply use the Save a
Copy As feature to save out a copy of your file in its current
state.  When you use the Save a Copy As feature, you’re
able to save copies at various stages, and keep working on
the original file, and maintain its unlimited edit history.

There are a number of ways to undo/redo edits in Peak –
one way is to use the Edit menu’s Undo and Redo com-
mands (the keyboard shortcuts for these are �-Z and �-
Y ), or, you may open the Edits dialog, which presents a
list of all edits that have been made in a file and allows you
to jump backward or forward as many edits as you like.
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Fig. 36 – You can undo/redo one edit at a time by using the File
Menu’s Undo/Redo commands.



To Undo Edits One at a Time:

1.  From the Edit menu, select Undo – one edit is
undone.

To Redo Edits One at a Time:

1.  From the Edit menu, select Redo – one edit is
redone.

To Undo Multiple Edits:

1.  From the Edit menu, select Edits... – Peak’s graph-
ical edit history list appears.

2.  Select the point in the file’s edit history to which
you would like to return.

3.  Click the Revert to Item button.

4.  Click the Done button – Peak returns to whatever
point in the file’s edit history you have chosen.

To Redo Multiple Edits:

1.  From the Edit menu, select Edits... – Peak’s graph-
ical edit history list appears.

2.  Select the point in the file’s edit history to which
you would like to return.

3.  Click the Revert to Item button.

4.  Click the Done button – Peak returns to whatever
point in the file’s edit history you have chosen.

The unlimited edit history is available until a file

is saved – once it is saved, the edit history disap-

pears!  If you wish to save copies of your audio
document at various stages of the editing process,
use the Save a Copy As command from the File
menu.  Using this command saves a copy to your
hard drive, and allows you to continue working
in the current audio document.

Markers

When working with a large file (a long recording, such as
two sides of a cassette), it can be difficult to locate a par-
ticular section just by looking at the audio waveform.  In
these cases, it is handy to use Reference Markers.
Reference Markers make it easy to locate a particular
event in an audio recording.  You might place Markers at
the beginning or end of a song, or you might mark the
silent area that was recorded while we changed the cas-
sette from Side 1 to Side 2.

Reference Markers may be dropped into place during audio
playback or when audio playback is stopped.  Either method
simply requires selecting the New Marker command from
the Action menu, or clicking the New Marker button in the
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Fig. 37 – In addition, you can open Peak’s edit history list to move
backward or forward as many edits as you like (you must have made
edits in a document for this list to appear!)

Fig. 38 – The Edits window allows you to jump backward or forward
as many edits as you like.



toolbar, or using the keyboard shortcut (�-M).  Whether
audio is playing or not, Markers are always placed exactly
where the play cursor is placed in the audio waveform.

Markers may also be dropped into place during a record-
ing, which makes locating events in the recording much
faster.  For example, while recording a cassette, you
could mark the beginning of each song during the
recording process, making the CD mastering process
faster and easier.  We won’t get into inserting markers
during recording in this tutorial, but you can find more
information in the Peak User’s Guide in Chapter 4:
Recording.

Each audio document can contain hundreds of Markers,
and Markers may also be custom named to make file nav-
igation and editing much easier.  

By default, the first marker created is named “Marker 1”,
the second “Marker 2” and so on.  To change the name of
a Marker to something more useful for reference, dou-
ble-click the triangular flag at the base of a marker.  The
Edit Marker dialog will appear and let you change the
name, adjust the position in time, and provide addition-

al options.  Marker positions may also be changed by
clicking on the small triangular flag at the base of a mark-
er and dragging it to a new location.

Regions

In addition to standard reference markers, which simply
define a particular point in the audio waveform, Peak also
offers another type of marker.  Region markers define a
range of audio – so there is always a beginning and an
end marker.  Region markers are most commonly used to
define what will become a single CD track, but they can
also be used in any other situation where you need to
define a range of audio.

In the context of our cassette recording project, we’ll be
using Regions to define each song/section of the cassette
that should eventually become a single CD track.  Make
sure the audio document we recorded from cassette is
open in Peak, and follow the steps below to mark each
song/section as a separate Region.

To Define CD Tracks Using Regions:

1. Look in the File Overview for gaps in the audio
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Fig. 40 – Region markers in the waveform define a range of audio

Fig. 39 – Markers are very useful for designating areas of interest in
an audio waveform.
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wavefom – this is a fast and easy way to locate the
pauses between songs (or the silent areas between
passages of dialogue).

2.  Click in the File Overview, (see Fig. 42 on the next
page) just before the first of these gaps – audio
playback should begin slightly ahead of the gap, so
you should hear the end of first song.

3.  When audio playback reaches the gap between the
first and second songs, press the Spacebar on your
keyboard to stop playback.

4.  Now that you’re in the area where the break should
be between the first and second songs, click into
the lower waveform display exactly where you
would like this break to be – notice the dotted ver-

tical line that appears wherever you click.

5.  From the Action menu, select New Marker.

6.  In the File Overview, look for the next gap
(between songs 2 and 3), and click into the
Overview just before this gap.

7.  As audio playback reaches the silent gap between
the second and third songs, get ready to add the
next Marker using a keyboard shortcut (�-M).
When Peak’s cursor reaches this silent area, just
hold down the Command (Apple) Key on your key-
board, and press the M key to drop a marker in
place.

If you don’t place the marker in exactly the right

spot, you can always move it later by clicking on
the small triangular base, and dragging it to the
left or right.

8.  Now, repeat this process until you have placed a
marker in each gap between each of the songs.

9.  Once you have placed all the markers, save your
work!  

You’ve spent a good amount of time editing so far, so this

Gaps between songs

Cursor

Fig. 41

Fig. 43 – Markers now divide each song



Getting Started with Peak20

Fig. 42a – Clicking in a gap in the File Overview will start playback very close to a gap between songs...

Positioning Markers Between Songs

Fig. 42b – Then you can position your cursor in exactly the right position...

Fig. 42c – And a reference marker can be dropped in place to designate a track break for our finished CD.



is a good point to save your work.  Now that you’ve
placed regular reference markers into the recording, it’s
time to create Regions – each of which will become a
separate CD track.

10. From the Action menu, select Zoom Out all the
Way – now, in the lower waveform display, you will
be able to see the entire recording from beginning
to end.

11.  Press the Tab key on your keyboard a number of
times, and notice that each time you press it, Peak
highlights one of the songs.

What Peak is actually doing is automatically selecting the
spaces between the markers that you’ve created.  Since
regions must be created around a selected portion of the
audio waveform, this is an easy way to ensure the entire
song is selected, while any audio beyond the beginning
or end of the song is not.

12.  Now, hold down the Command (Apple) key and
click between any two markers – notice that only
the space between the two markers is selected (so
just a single song is selected).

These two methods will be very helpful in creating accu-
rate region markers, and will also make the process
much faster.  If you use these tips and also learn some of
the key commands for creating markers and regions,
you’ll be amazed at how much editing you can get done
in a short amount of time!

13.  Press the Tab key until the very first song is select-
ed (Peak’s automatic selection will “wrap” to the
beginning of the file when it reaches the end).

14.  From the Action menu, select New Region (or click
the New Region button in the Toolbar, or use the
keyboard shortcut �-Shift-R) – the Edit Region
dialog appears.
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Fig. 47 – Regions are always based on a selected portion of the wave-
form – so here, we’ve selected just the first song.

Fig. 44 – Pressing the Tab key once selects the space between the first two

Fig. 45 – Pressing it again selects the next space between markers

Fig. 46 – And so on...  When you reach the end of the document, Peak will
“wrap” back to the beginning and select the space between the first two mark-

Fig. 48 – The Toolbar’s New Region button is an easy way to place
Region markers around a selection



15.  In the Edit Region dialog, enter a name for this
region and click OK.  In the audio waveform,
notice that the first song is now bounded by two
region markers, and each one has the name you
entered in the Edit Region dialog.

16.  Press the Tab key on your keyboard to select the
next space between the next set of markers – this
will select just the second song.

17.  From the Action menu, select New Region (or click
the New Region button in the Toolbar, or use the
keyboard shortcut �-Shift-R) – then enter a name
for the second region.
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Fig. 52 – This picture shows the second song selected, with region
markers called “Song 2” added.

Fig. 53 – In this view, we’ve zoomed out all the way, so we can see all the Regions in the entire document – notice that each song now is con-
tained within a pair of region markers.

Fig. 50 – Notice that the first song now has Region markers bounding it.

Fig. 51 – Pressing the Tab key selects the next space between mark-
ers, in this case, it’s the second song.Fig. 49 – Naming Regions makes them easier to locate later if necessary.



18.  Repeat this process until you have created a region
for each song in the entire recording (shown in Fig.
53).

19.  Once you have placed all the regions, save your
work!  

You’ve now completed the basic steps for creating
regions – with each one ready to become an individual
CD track.  However, there can be occasions when you
would like to adjust the length of a region for one reason
or another.  For example, when we recorded from the
cassette into Peak, we left Peak recording while switching
the cassette from Side 1 to Side 2.  This left a long silent
gap in the middle of the audio document.  By adjusting
the regions in the area, we can exclude this long gap, and
the CD we create will go directly from the last song on
Side 1 into the first song on Side 2.  The next few steps
will show you how to trim/adjust regions.

To Trim/Adjust Regions:

1.  Find the spot in the middle of your audio docu-
ment where silence was recorded while the cas-
sette was changed from Side 1 to Side 2 (Fig. 55).
You may use the File Overview to quickly find this
by looking for a long section with a very low ampli-

tude audio waveform that appears like a flat line.

2.  When you locate this part of the recording, click
directly over the single reference marker and the
two region markers in this area – they should all be
located in the exact same position.

3.  Use the Zoom In button on the Toolbar to zoom in
for more detail(Fig. 56).

4.  Move the End Region Marker for the last song on
Side 1 closer to the end of the song, using the
waveform for reference (Fig. 57).

On the cassette recorded by the author, there were
seven songs on Side 1 of the cassette – your cassette
may have a different number of songs.  The last
song on Side 1 of your cassette may not be labeled
“Song 7”.
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Fig. 54 – You can use the Zoom buttons for greater detail

Fig. 55 – The highlighted section between songs 7 & 8 is the long pause that was recorded when we switched the cassette from Side 1 to Side 2.
By trimming the regions that bound this silent area, we can exclude it from our final CD.
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Fig. 57 – Then, we can adjust the end region marker for Song 7 to the left...

Fig. 58 – And we can adjust the begin region marker for Song 8 to the right...

Fig. 59 – Since the highlighted area does not fall within any region markers, it will be excluded from our audio CD

Fig. 56 – First, we’ll want to zoom in on this area so as to get a more detailed view...



5.  Move the Begin Region Marker for the first song on
Side 2 closer to the beginning of the song, using
the waveform for reference(Fig. 58).

When multiple markers occupy the same space in

the waveform, you may have to move one out of
the way to be able to move another.  Now that
regions have been created, the standard reference
markers are not important any more, so if you
move a reference marker out of place to access a
region marker, don’t worry about putting the ref-
erence markers back into their original position.

Now that we’ve moved the region markers in closer to
the actual audio data intended for the CD, the long silent
gap now lies outside of the region markers (shown in Fig.
59).  Only audio that lies within a pair of region markers
will become a CD track when we build a Playlist (in the
next section).

From time to time, there will be other sections of a
recording that you will want to exclude from the CD
that’s being created.  For example, sometimes when
recording on a cassette, the tape will run out before a
song finishes.  When you listen to the cassette, the last
song will sometimes be cut off.  As anyone who likes lis-
tening to “mix” tapes can tell you, there’s nothing worse
than hearing the first half of a favorite song and then hav-
ing it cut off because the tape ended during the record-
ing.  With digital editing, it’s easy to remove a partial
song, or any other section of a recording.  

You may use the same techniques as those above to trim
a region’s length to include only the desired audio.
Another option is to simply not use certain regions.  For
example, if while browsing through the File Overview
you created a region for a song that was cut off before it
was completely recorded on the original cassette, you

can simply not use that region when assembling your
Playlist.

Note that as we’ve been isolating one song from another,
we have not deleted a single part of the recording.  By
using Peak’s reference markers and region markers,
we’re able to separate various pieces of audio without
cutting, copying, or pasting!

Before we get to the last step of assembling our Playlist
and burning a CD, we’ll use a few of Peak’s DSP tools to
enhance the overall quality of the recording.

DSP Tools

The menu in Peak titled “DSP” stands for Digital Signal
Processing.  This references features that are built into
Peak that process your audio in some way.  If you click on
the DSP menu you will see a list of DSP items available.  

Some of these may be grayed out.  If some of your DSP

items are grayed out, it means that you are using
either Peak Express, Peak LE, or Peak DV and those
features are not included in your version of Peak.

The DSP tool that we’re going to work with is
“Normalize”.  Normalizing is one of the most common
processes used in digital audio editing and is used to
raise audio levels.  Normalizing a file is a safe way to raise
the level of a digital audio file without danger of raising
the level too high, and introducing digital distortion
(clipping).  This feature works by first analyzing a select-
ed portion of audio, finding the highest waveform peak,
and raising that to the level that you specify, while bring-
ing up all other peaks proportionally.  By normalizing
each of the songs in the cassette recording, we’ll end up
with a CD that has more or less constant levels from one
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song to the next – this allows the listener to enjoy the
music without having to adjust the volume on their CD
player for each song.

We can quickly and easily normalize each song using
some of the things we’ve already learned, and adding
one new tool.  Follow the steps below...

To Normalize Each Song’s Level:

1.  Hold down the Command (Apple) key, and click
between the first song’s region markers – this will
select just the first song.

2.  From the DSP menu, select Normalize.

3.  In the Normalize dialog, move the slider to the
100% position (all the way to the right).

4.  Click the OK button – Peak normalizes the selected
portion of the waveform.  You should notice an
increase in the amplitude of the waveform (the wave-
form will look larger, as the level has been raised).

5.  Press the Tab key on your keyboard to select the
next space between markers – this should select
only the second song.

6.  From the DSP menu, select Normalize.

7.  In the Normalize dialog, move the slider to the
100% position (all the way to the right).

8.  Click the OK button – Peak normalizes the select-
ed portion of the waveform.

9.  Repeat this process until you have normalized all
the songs (Fig. 64).

Remember the long gap in the middle of the
recording?  Since using the Tab key selects the
spaces between markers, and we’ve adjusted some
of the markers in this part of the file, you may need
to press the Tab key a number of times to go from
having the last song from Side 1 selected, to having
the first song on Side 2 selected.

10.  Save your work!
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Fig. 62 – ...And the higher amplitude level after normalizing.

Fig. 60 – Notice the low amplitude of the waveform before we normalize

Fig. 61 – Normalizing raises the audio level according to what you
specify.



There are other DSP tools for applying different

kinds of processes to your audio.  For a detailed
description of each tool, please refer to the Chapter
7 in your Peak User’s Guide.

Plug-ins

In addition to the built-in DSP tools, Peak also supports
VST and Audio Units plug-ins.  Think of plug-ins as “mini-
applications” that “plug-into” a host application.  Plug-ins
add a specific type of processing to the host application.

Peak is compatible with VST (these must be Mac OS X
compatible VST effects!) and Audio Units plug-ins.  Many
manufacturers create plug-ins that conform to the these
two standards.  If a plug-in conforms to these standards,
it will work in Peak.

When shopping for new plug-ins to use with Peak,
READ THE PLUG-INS’ SYSTEM REQUIREMENTS!
Make sure that VST plug-ins are compatible, (some
VST effects only work on Windows or Mac OS 9.x!).
In addition, make sure that what you are consid-
ering is a VST or Audio Units “Effect Plug-In” and

not an “Instrument Plug-in” – Peak currently sup-

ports only effects plug-ins, not instrument plug-ins!

We’re not going to use any effects plug-ins in this project, as
this is a very basic Peak tutorial.  Once you have mastered
the techniques introduced in this tutorial, you can learn
about how plug-ins work in several other BIAS tutorials,
such as “Cleaning Up Audio Files”, and “Mastering a CD in
Peak” – both available for download from the BIAS website.

Now that we’ve created regions, we’re ready to build a
Playlist, and burn an audio CD!
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Fig. 63 – Note low amplitude before normalizing entire recording

Fig. 64 – ...And high amplitude after normalizing each song.



Playlists

Playlists are another kind of document that can be creat-
ed in Peak, used for arranging regions in a particular
order for playback.  Some common uses for Playlists are
CD mastering/CD burning and remixing.  In this project,
we’ll be using the Playlist for CD mastering/burning.  The
Playlist we create in Peak will become the “blueprint” for
the finished audio CD.  To learn more about using Peak’s
Playlist for creating remixes, please download the “Peak
Looping Tools” tutorial from the BIAS website.

To Create a Peak Playlist Document:

1.  From the File menu, select New>Playlist
Document – an empty Playlist appears.

2.  From the Window menu, select Contents – the
Contents window appears.

3.  Arrange Peak’s windows so that you can easily see
the audio document window, the Playlist, and
Contents window. (See Fig. 70 on following page)

4.  Click the disclosure triangle in the Contents palette,
just to the left of the audio document’s name – a
list of regions contained in that file appears.

5.  Select the first region that appears under the audio
document’s name, and drag this into the Playlist
window.
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Fig. 68 – Just drag and drop the region into your Playlist

Fig. 69 – The Playlist now contains one item – an audio CD burned at

this point would contain just one track

Fig. 67 – Clicking the disclosure triangle next to an audio document’s
name reveals a list of all the regions in that document.

Fig. 65 

Fig. 66 



6.  Select the second region that appears under the
audio document’s name and drag it into the
Playlist.

You should now have two items in your Playlist.  If you
were to burn a CD at this point, each of these items
would be a separate track, resulting in a two song CD.  If
you wish to burn a CD that has all the songs from the cas-
sette on it in the same order they appear on the cassette,
there’s an easier way to do it, rather than dragging and
dropping each region.

You can drag regions into the Playlist in any order

you like – if you wish to automatically place *all*

the regions contained in a file into the Playlist, in
the order they appear in the audio document, sim-
ply click on the audio document’s name in the
Contents palette and drag it into the Playlist win-

dow – all the regions contained in that document

will be added to the Playlist.

7.  With the Playlist window in the foreground, choose
the Select All command from the Edit menu (or
use �-A).

8.  Press the Delete key on your keyboard – the
Playlist’s contents are cleared.

9.  In the Contents window, click on the audio docu-
ment’s name, and drag it into the Playlist (shown in
Fig. 72 on next page) – all the regions contained in
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Fig. 71 – The Playlist now contains two items – an audio CD burned

at this point would contain just two tracks

Fig. 70 – Arranging Peak’s windows as shown will allow easy access to everything you need to build a Playlist.



the document are automatically added to the
Playlist.

10.  Save the Playlist!

If desired, you may add a standard two second gap
between songs...

11.  In the Playlist window, double-click on the second
song’s row, under the “Gap” column – The Gap
Time dialog appears.

You cannot add a two second gap to the first item

in a Playlist, as there is no audio data preceding
the first item/song/region!

12.  Enter in 2 seconds as the value you would like to
add as a gap time, and click the OK button (Fig. 75).

13.  Repeat this process for the rest of the gaps
between songs, and add the desired gap time.  

14.  Save the Playlist!

Playlists are very small documents (in file size), and

they do not contain any audio data at all!  Playlists
simply refer to the audio contained in various
regions, which are contained in audio documents.  If
you wish to move your Playlist to another computer
system, or back it up, you will need to include all the
audio documents used in creating the Playlist!

Now that the Playlist contains all the regions we want,
let’s burn a CD!  To create a Red Book format audio CD
that will play in any CD player, just follow the steps
below.

To Burn an Audio CD from a Peak Playlist:

1.  With your Playlist assembled as desired, choose
Select All from the Edit menu – this indicates that
you wish to include every item in the Playlist on
your CD (only selected items will be included on
the CD!).
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Fig. 74 – Double-clicking in the Gap Time column brings up the Gap
Time dialog, allowing a custom gap time to be entered.

Fig. 72 – Dragging an audio document’s name from the Contents
palette to the Playlist automatically places all the regions from that
document sequentially into the Playlist.

Fig. 73 – A complete Playlist, with all 17 songs from the cassette...

Fig. 75 



2.  In the upper left portion of the Playlist window,
click the Burn Audio CD button – the Burn Audio
CD dialog appears.

3.  In the Burn Audio CD dialog, select speed at which
you wish to burn the CD (1x, 4x, 8x, etc.).

In general, lower burn speeds are less likely to pro-

duce errors and data loss.  For higher quality CD
burning use lower burn speeds.  In most cases the
fastest speed supported by your CD burner is typi-
cally fine, though depending on the blank CD
media you’re using, you may need to adjust this if
you notice anomalies such as clicks or pops, or
dropouts of audio on the CD.

4.  Click the Burn button – Peak will prompt you to
insert a blank CD into your CD-ROM drive.

5.  Insert a blank CD, and click the OK button – Peak
begins to burn your audio CD.  You may monitor
this progress in the Transport window (Peak’s
meters change to a progress bar which indicates
CD burning status).
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Fig. 78 – To burn your Playlist to CD, just click the Burn button in the
upper left corner of the Playlist window...

Fig. 80 – Peak will prompt you for a blank CD

Fig. 76 – Be sure to Select All in your Playlist, as only selected items
will be burned to CD!

Fig. 77 – A Playlist with all items (regions) selected

Fig. 81 – The transport window’s VU meters change to a progress bar
during CD burning, giving you information about the status of the
burning process.

Fig. 79



6.  When the CD is finished burning, Peak will alert
you – click the OK button.

Congratulations!  You’ve now successfully recorded a cas-
sette, added reference and region markers, performed
some basic edits, assembled a Playlist, and burned a CD
that will play in any standard CD player, as well as in soft-
ware audio players such as iTunes, and Quicktime Player.
If you own an iPod, you can also import the audio CD
into iTunes and transfer the songs to it.  Now, go listen to
your creation!

For more detailed information about Peak’s features,
please consult the Peak User’s Guide, which was installed
on your hard drive when you installed Peak.

Peak is also capable of creating mp3 and AAC (mp4)
files, which can be imported directly into iTunes (and
other software-based audio players), and transfered
into an iPod.  If your goal is to transfer your cassette
or LP collection to an iPod, this eliminates the step of
having to burn an audio CD to import into iTunes.
Look for a tutorial on transferring your cassette or LP
collection to an iPod, coming soon!

Methods of Connecting Stereo/Audio
Equipment to a Macintosh Computer

Some users may not have the same type of Macintosh, or
the same type of stereo equipment used in this tutorial.
Several examples are included below for other common
stereo equipement, as well as other common methods of
connecting stereo equipment to a Macintosh computer.
By reviewing the examples below, you should be able to
connect your own stereo equipment to your Mac and use
the other steps in this tutorial to record cassettes into
Peak.

If you need to purchase any of the cables mentioned
below, visit your local electronics or electronic music
store.

Micro-Cassette Recorder (1/8” Stereo/Mono
Output) to Mac (1/8” Stereo Input)

If you are using a micro-cassette recorder, and wish to
record these cassettes into Peak, you will most likely be
using a 1/8” mono to 1/8” mono cable or a 1/8” stereo to
1/8” stereo cable.  You may follow along with all other
steps in the section of this tutorial called “To Connect
Your Audio Devices Together”.
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Fig. 83 – Most micro-cassette recorders have a 1/8” output. – some
are mono, some are stereo

1/8” output

Fig. 82 – Your CD in now ready to play in a CD player!



Cassette Player (1/8” Stereo Output) to Mac with
Griffin iMic, Edirol UA1A, or Similar USB Audio
Device

If you are using a Macintosh model with no built-in audio
input, you will need to use some type of audio hardware
interface.  At the most basic level you will want a device
such as the Griffin Technologies’ iMic, or the Edirol
UA1A.  These are simple USB devices that plug into an
available USB port on your Macintosh and feature basic
audio inputs and outputs.  The iMic features a 1/8” stereo
input and the UA1A features stereo RCA inputs.  

To connect a cassette player with an 1/8” stereo head-
phone output to an iMic-equipped Macintosh, you will
need a 1/8” stereo to 1/8” stereo cable (shown in Fig. 89
on following page). Connect one end of the cable to the
cassette player’s headphone output and the other end to
the iMic’s audio input.

To connect a cassette player with an 1/8” stereo head-
phone output to an Edirol UA1A-equipped Macintosh,
you will need a 1/8” stereo to RCA cable.  Connect one
end of the cable to the cassette player’s headphone out-
put and the other end to the UA1A’s RCA inputs.

Once the connection is made, you will need to configure
your Macintosh to use this additional hardware device
for audio input.

Getting Started with Peak 33

Fig. 85 – The Griffin Technologies iMic features 1/8” stereo input and
output

Fig. 87 – The Edirol UA1A features RCA input and output

Fig. 84 – The cable you need to use in this configuration has this type
of connection (1/8” mini-plug) at both ends. Fig. 86 – The cable used to connect these two devices together has a

1/8” stereo connector at both ends

Fig. 88 – The cable used to connect a cassette player to an Edirol
UA1A has a 1/8” stereo connector on one end and RCA connectors on
the other end.



When you have configured your Macintosh to use the
iMic or UA1A for audio input, you may continue with this
tutorial – just be sure to skip the section called “To
Configure System Preferences for Sound”, as you will be
configuring your system according to the directions in
the Hardware Setup Appendix of this tutorial.

Stereo Amplifier (RCA Output) to Mac (1/8” Stereo
Input)

If you are using a stereo amplifier, rather than a cassette
player, you can connect the RCA outputs from your
amplifier to your Macintosh in a similar way as you would
if using a cassette player.

To connect to a Mac this way, you’ll need an RCA to 1/8”
stereo cable.  Connect this from the amplifier’s RCA out-

put to the Mac’s 1/8” stereo input.  Then, follow the steps
starting in the section of this tutorial entitled “To
Configure System Preferences for Sound”.
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Fig. 90 – Two common examples of RCA outputs on an amplifier

Tape Out

Line Out

Fig. 89 – Macintosh computers that do not feature built-in sound input will need to use some type of audio interface – the Griffin iMic is
shown above, plugged into a USB port.  The audio output from the stereo equipment feeds into the audio input of the iMic, then into the com-



If you are using other types of stereo equipment

If you are using other types of stereo equipment not cov-
ered in the examples above, you will want to look for
some kind of audio output connection on the device you
wish to record from (your recording “source”).  Typical
connections include 1/8” mono, 1/8” stereo, RCA, 1/4”
mono, and 1/4” stereo.  If you are using a connection
method not mentioned above, you may need to pur-
chase the correct type of cable.  Usually you can find spe-
cial cables with the proper connection type on either end
at your local electronics or electronic music store.  Once
your equipment is connected together, you may config-
ure your Mac’s Sound Preferences, using the examples
above for reference.

For help with connecting unusual types of stereo equip-
ment to a Macintosh, you may wish to visit the BIAS
Forums, where BIAS software users ask and answer ques-
tions, about BIAS software.  You can visit the BIAS
Forums at:

http://www.bias-inc.com/support/userForums/

You may also contact BIAS directly at:

Email:  support@bias-inc.com

Phone:  +1-707-782-1865

Hardware Setup Appendix

To Configure Peak for Recording with a Griffin iMic:

1. Without Peak launched, connect the iMic.

2. Go to your System Preferences>Sound, and set
the iMic as the input and output device.

3. Go to the Audio Menu>Hardware Settings and
select the iMic  as your input and output device.

4. Go to Audio>Record Settings>Device and
Sample  Format. Here you can use the menu to
select your bit depth,  sample rate and other input
settings.

If you have the iMic set up correctly and cannot
get any  levels to show up in Peak, try switching the
small black  switch on the iMic. This switch will
alternate between  adding +4dB or cutting
–10dB, which will boost or  lower your signal
accordingly.

To Configure Peak for Recording with the Edirol UA1A:

1. If your Edirol device requires drivers, download
the  latest version from Edirol’s website.

2. Without Peak launched, connect the Edirol device
and turn it  on.

3. Launch Peak and go to the Audio Menu>Sound
Out and verify  that you have CoreAudio selected.

4. Go to the Audio Menu>Hardware Settings and
select the Edirol  as your input and output device. 

5. Go to the Audio Menu>Record Settings>Device
and Sample  Format. Here you can use the menu to
select your bit depth,  sample rate and other input
settings.
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If the Edirol does not show up as an option under
hardware  settings, run your Audio MIDI Setup
utility to verify that  your OS is recognizing the
Edirol.

Due to the limited bandwidth of USB, if you are
going  to do 24 bit recording, you should go to your
Audio MIDI  Setup utility, choose the Edirol under
“Selected  Device” and set the output option for 16
bit.

Please visit our FAQ page for more information on USB
recording tips – this can be found online at:

http://www.bias-inc.com/support/faq/
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